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Introduction 
This tutorial assumes you are running the latest release of version 7.3 of the 
EFILive Tuning Tool software, please ensure you are running the latest software, 
free updates can be downloaded from http://www.efilive.com/download.aspx 
Your hardware must also be either licensed as Flashscan Commercial or 
Workshop. If you presently own a Flashscan Personal cable you will need to 
upgrade to use the DSP² programs. 
The Custom Operating Systems supplied by EFILive are provided “as is” without 
warranty of any kind. Please take all reasonable caution when using the extended 
features of EFILive’s Custom Operating Systems. 
You may return your ECM to its GM factory condition at any time, by reflashing a 
stock GM Operating System and calibration over the top of any EFILive Custom 
Operating System. 
 

What is EFILive DSP² ? 
DSP² is a customized ECM operating system developed by EFILive for the LB7 & 
LLY Duramax Diesels. 
DSP² lets you to switch on the fly between two user programmable tunes; DSP² 
does this by allowing you create two versions of the main operating maps that 
control engine performance.  
DSP² also offers you the feature of a switchable output using a spare pin on the 
ECM. This could be used for a variety of things, such as, switching a relay on/off, 
turning on a warning lamp under conditions that you can define (see hints on the 
last page of this document). 
Please follow the steps on the following pages to successfully upgrade your 
Duramax ECM to DSP².
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Step 1 
Using the EFILive Tune Tool, read the ECM to be converted to DSP² and save the 
file, or, open an existing *.tun file copy of the ECM and note the Operating System 
number. You will need to select the correct DSP² Operating System *.tun file from 
the list shown on the next page based on this number. You may wish to write this 
down for reference. 

 

You may wish to take note of the current Operating System in the ECM in the 
space below………..
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Step 2 
Using the table below, find the EFILive Custom Operating System that matches 
your ECM’s current Operating System number. 
The two numbers at the end of each DSP² filename may be 01, 02, 03, etc, this 
indicates the version number and feature-set of the EFILive Custom Operating 
System. At the time of writing only 01 is available. 
The .tun file is what is programmed into the ECM’s flash memory. 
The .cal file contains the mapping information for the Tuning Tool. 
 

Note: The listed year in the table refers to the year the ECM operating system was first 
released and then the various revisions of the first release, not the model-year of the 
vehicle. 

 

GM Operating Systems (O.S) vs EFILive DSP² Custom O.S 
 

GM O.S DSP² O.S Calibration file
(*.cal)

Tuning File 
(*.tun) 

2001  LB7 
09393838 01383801 01383801.cal 01383801.tun 

15063376 01337601 01337601.cal 01337601.tun 

15097100 01710001 01710001.cal 01710001.tun 

15188873 01887301 01887301.cal 01887301.tun 

2002  LB7 
15166853 02685301 02685301.cal 02685301.tun 

15186006 02600601 02600601.cal 02600601.tun 

15194441 02444101 02444101.cal 02444101.tun 

2003  LB7 
15189044 03904401 03904401.cal 03904401.tun 

2004 LLY 
15141668 04166801 04166801.cal 04166801.tun 

2005  LLY 
15193885 05388501 05388501.cal 05388501.tun 

15231600 05160001 05160001.cal 05160001.tun 

15228758 05875801 05875801.cal 05875801.tun 
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Step 3 
Open the EFILive DSP² Custom Operating system *.tun file from the list on the 
previous page that matches the ECM’s current GM Operating System.  
 

 
 
You should NOT use this tune as the one to run your truck, the following steps will 
show you how to transfer your existing tune from your truck back into the DSP² 
Operating System. 

When the supplied DSP² file opens EFILive will warn you that there is some table 
values out of range, this is normal as the tables will contain no data at this stage, 
we will populate them later. 
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Step 4 
Open as a *.tun file comparison, the file that contains the ECM’s original 
calibrations (or an existing tun file you are using in that ECM). 
 

 
 
Once this is done you should now see the DSP² file name as the main file and 
your ECM’s current (non DSP²) file as the alternate calibration. 
 

 
 
The compare calibrations button will also be active. 
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Step 5 
You now need to transfer over your existing calibrations into the DSP² file. This is 
done using the segment copy feature. 
From the menu choose – Edit > Copy entire segment. 

 
  
When you perform that step please take note of the confirmation window that pops 
up telling you that you are about to copy from the alternate calibration to the 
current calibration, it must not say from the current calibration to the alternate 
calibration. 

 
Then save the file. 
You will need to repeat this process (copy then save) for all segments shown in 
the picture on the next page. 
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Step 5 continued 
Do not copy the “EFILive Custom Calibrations” segment, just those in the red 
square. 

 

For LB7 For LLY 

  

 
Once all segments have been copied your saved file will now contain the DSP² 
program, but now with the calibrations from your truck installed. This is an 
important step as GM has many different calibrations for each model truck to cover 
different tire sizes, A/C configurations, emissions compliance etc. What you 
program back into your truck must match what was originally in the ECM. 
The next few steps involve populating the new DSP² tables as they will be blank. 
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Step 6 
Ensure the display units (imperial or metric) for the DSP² tables are set the same 
as the tables you are about to copy the data from (the list of tables to copy can be 
found on page 13 of this document). 
This is done via the menu option Edit >> Configure Display Units 
You only need to configure or confirm the Table / Parameter ID’s that have 
something shown in the Data Units section (such as A0101 shown below). 
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Step 7 
Open the first segment in the Navigator, called EFILive Custom Calibrations, 
you now need to fill these tables / parameters with values to be used for your 
switched tune. As a starting point, the best option is to copy your existing standard 
tables into the DSP² tables. 
 

 
 
Continued next page: 
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Step 7 Continued 
 
EFILive Custom Calibrations parameters, set them to the following values 
(suggested starter settings): 

• {A0112} DSP² Vehicle Speed Limit (Upper): 250MPH / 410KMH  
• {A0113} DSP² Vehicle Speed Limit (Lower): 250MPH / 410KMH  

 
EFILive Custom Calibrations >> DSP² Output #1 parameters, set them to the 
following values (suggested starter settings): 

• {A0115} DSP² Output Enable:  Disable 
• {A0116} DSP² Output TPS Min: 50% 
• {A0117} DSP² Output RPM Max: 5000 
• {A0118} DSP² Output RPM Min: 1000 
• {A0119} DSP² Output Boost Max: 40psi / 275kPa 
• {A0120} DSP² Output Boost Min:  8psi / 55kPa 
• {A0121} DSP² Output Coolant Max: 250F / 120C 
• {A0122} DSP² Output Coolant Min: 32F / 0C 
• {A0123} DSP² Output Torque Value Min: 0 
• {A0124} DSP² Output Torque Reduction: Disable 

 
Continued next page: 
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Step 7 Continued 
Now copy all the tables needed as a starter into the DSP² 3D maps (See list 
below). To copy an entire table, click on the top left corner of the non DSP² table to 
highlight all the cells then press (Ctrl+C), then switch to the matching DSP² table 
and click the top left corner again to highlight the entire table and press (Ctrl+V). 

LLY Desired Boost Levels shown as an example: 

Highlight Table & Copy Highlight blank DSP² table Paste copied table 

 
 

 
 

 

Click top corner to 
highlight all cells then 
press Ctrl+C. {B2206} 

Click top corner to 
highlight blank DSP² 

table. {A0101} 

Press Ctrl+V. {A0101} 

Table is now populated 

LB7 LLY 

{B0504} copy into {A0101} {B2206} copy into {A0101} 

{B0727} copy into {A0102} {B0727} copy into {A0102} 

{B0728} copy into {A0103} {B0728} copy into {A0203} 

{B0722} copy into {A0104} {B0722} copy into {A0104} 

{B0720} copy into {A0105} {B0720} copy into {A0105} 

{B0721} copy into {A0106} {B0721} copy into {A0106} 

{B0910} copy into {A0107} {B0910} copy into {A0107} 

{B0929} copy into {A0108} {B0929} copy into {A0108} 

{B0741} copy into {A0109} {B0744} copy into {A0109} 

{B1102} copy into {A0110} {B1105} copy into {A0210} 

{B1001} copy into {A0111} {B1001} copy into {A0111} 

 {B2206} copy into {A0114} 
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IMPORTANT 
You have just about completed the EFILive DSP² upgrade. 
Save the tune in a new *.tun file – use the menu option File->Save as… which will 
automatically increment a sequence number on the end of the file name. Each 
time you alter the calibration use File->Save as… That way you create a 
sequenced history of changes, allowing you to revert to a previous file should you 
need to. 
This *.tun file will become your “base calibration” for the upgraded Operating 
System. Always keep a copy of this file in case you need to restore your ECM to 
its initial Custom Operating System state. Preferably, make a backup of it onto a 
CD and store it in a safe place or Email it to a friend. 
The final step is to now do an entire ECM reflash with the new DSP² operating 
system and calibrations.   
 
Hints for in-vehicle ECM flashing:  

• Ensure your vehicle is keyed to ON without the engine running. 

• Turn off, or even better, disconnect any aftermarket entertainment devices, 
pull radio fuse if necessary. Some aftermarket entertainment devices will 
interrupt the reprogramming procedure possibly leaving the ECM in an 
unrecoverable state. 

• Ensure the battery is in a good state of charge. 

• If fitted with On-Star, turn it off. 
 

You will need to perform a ‘Full Reflash’ of your ECM to use the newly created 
DSP² operating system and calibrations. Once this completes successfully you will 
only need to do ‘Calibration’ flashing for normal tuning procedures. 
The EFILive Tuning Tool manual covers reflashing procedures, it is highly 
recommended you also refer to that document whilst performing this programming 
procedure as this covers the correct steps for performing the full ECM flash and 
how to go about ECM recovery should something go wrong. 
With your DSP² file loaded press the button circled in the picture below. 

 
 
Once the full flashing procedure finishes (approx 3 mins) then turn off the IGN for 
at least 30 seconds to allow all the vehicle modules to fully shutdown. 
Next, start the truck and ensure everything is running and operating correctly (A/C, 
cruise control, etc). 
Once these tests are complete you can wire up your DSP² switch and DSP² 
programmable output (if not already done). Once that is complete you can start 
tuning your DSP² program. 
 



DSP² Custom Operating System Tutorial EFILive V7 Tuning Tool 

support@efilive.com - 15 - www.efilive.com 

 

Wiring your ECM for DSP² Program switching operation 
To switch between the normal ECM tables and the DSP² tables you must install a 
toggle switch and wire it to your ECM. 
When the switch is switched to ground (negative) the ECM will use the DSP² 
tables. Choose the ECM type and wire the switch as follows. 
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Wiring your ECM for DSP² Output operation 
As well as wiring up the output, also please check the operational settings in the 
DSP² Output #1 section of the *.tun file. 
WARNING: Do not wire this output directly to heavy duty solenoids such as N2O 
controls, such solenoids must be switched via a relay, permanent damage to the 
ECM will occur if this is not done. Also do not use high wattage lamps. 
Choose the ECM type and wire the output as follows. 
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LB7 ECM Connector wiring installation 
 

#1 – Remove TCM cover #2 – Lift out TCM #3 – Disconnect TCM 

#4 – Remove ECM cover #5 – Unbolt blue plug #6 – Remove blue cover 

#7 – Pins now exposed #8 – Insert new pin/wire #9 – Re-assemble 

 
 

Installation photos courtesy of Tony Nostedt  
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LLY ECM Blue Connector (Repeat for Black connector) 

 
#1 - Lift Grey lever #2 - Detatch plug #3 - Lift grey cover 

 
#4 - Grey cover lifted #5 - Now removed #6 - Remove pin lock 

   

#7 - Remove pin filler #8 - Keep pin lock safe #9 – Insert new pin & wire

   
#10 – Push in pin to latch #11 – Reassemble 6 & 4 #12 - Finished 

   

The LLY ECM also has the connector pin numbers stamped on it’s case for 
confirmation, though these can be difficult to see when the ECM is fitted to 
the vehicle. 

Installation photos courtesy of Tony Nostedt
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Some DSP² Program usage ideas 
 

Valet Mode: 
With DSP² setup as follows you could limit the maximum truck speed and limit 
engine power using your hidden switch. 
You can set the DSP² speed limit parameters to a lower setting than standard 
depending on what you want the maximum speed limit to be, to stop thieves you 
could set this to 10MPH, to stop young drivers going too fast you could set this to 
60 – 70MPH. 
Reducing engine power may be another option, you could reduce table {A0103} 
LB7 or {A0203} LLY, this table will limit the amount of fuel that can be injected, 
therefore limiting engine power. 
Using either one of these methods (or both) you can rest easy knowing your truck 
will not ‘perform’ above the limits you apply. 
 

N2O / Propane Mode: 
With DSP² setup as follows you could provide different fuel and timing when N20 
or Propane is being used. Then used in conjunction with the DSP² programmable 
output you can have a built in safety shutoff feature. 
As an idea, you could wire up the DSP² input to a relay that is switched to ground 
when your N20 is switched on, therefore whenever the N2O is on your ECM 
automatically uses the DSP² fuel and timing maps. As a safety factor, you could 
use a relay to provide a master shut off (kill switch) to the N2O system in the event 
of an over-rev or if you lift off the throttle. Look through all the parameters in the 
DSP² Output #1 section.  
For example, you might setup the DSP² Output #1 to shutoff if the throttle falls 
below 80% or the RPM’s go above 4000 (missed gear on a manual trans). 
 

Over boost / Over Temp warning: 
Still using the parameters in the DSP² Output #1 section you could set {A0120} 
Minimum boost setting to the value you wish your warning lamp to illuminate at 
then set {A0119} Maximum boost setting to the maximum allowed value. You will 
also need to set all other parameters to a value they will always allow the output to 
function. This way, when the boost level hits the minimum value you set, the 
output will be switched on. 
Similar to an over boost warning this could also be used for racing situations 
where the driver want to build consistent boost levels when staging, in which case 
the lamp will switch on once a preset boost level is reached. 
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